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Legal Notices

Warranty

The only warranties for HP products and services are set forth in the express warranty statements 
accompanying such products and services. Nothing herein should be construed as constituting an additional 
warranty. HP shall not be liable for technical or editorial errors or omissions contained herein.

The information contained herein is subject to change without notice.

Restricted Rights Legend

Confidential computer software. Valid license from HP required for possession, use or copying. Consistent 
with FAR 12.211 and 12.212, Commercial Computer Software, Computer Software Documentation, and 
Technical Data for Commercial Items are licensed to the U.S. Government under vendor's standard 
commercial license.

Copyright Notices

© Copyright 2002 - 2007 Hewlett-Packard Development Company, L.P.

Trademark Notices

Java™ is a U.S. trademark of Sun Microsystems, Inc.

Oracle® is a registered U.S. trademark of Oracle Corporation, Redwood City, California. 

UNIX® is a registered trademark of The Open Group.

Windows® and MS Windows® are US registered trademarks of Microsoft Corporation.
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Documentation Updates

This guide’s title page contains the following identifying information:

• Software Version number, which indicates the software version.

• Document Release Date, which changes each time the document is updated.

To check for recent updates, or to verify that you are using the most recent edition of a document, go to:

http://ovweb.external.hp.com/lpe/doc_serv/ 

You will also receive updated or new editions if you subscribe to the appropriate product support service. 
Contact your HP sales representative for details.
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Support

You can visit the HP software support web site at:

http://support.openview.hp.com/support.jsp 

HP Software online support provides an efficient way to access interactive technical support tools. As a valued 
support customer, you can benefit by using the support site to:

• Search for knowledge documents of interest

• Submit and track support cases and enhancement requests

• Download software patches

• Manage support contracts

• Look up HP support contacts

• Review information about available services

• Enter into discussions with other software customers

• Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. Many also require a 
support contract.

To find more information about access levels and HP Passport, go to:

http://support.openview.hp.com/new_access_levels.jsp 
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1 Overview
This chapter covers the following topics:

• OVPI and Access Rate Reporting

• QoS and Committed Access Rate (CAR)

• Package Version History

• Ways to Customize Reports

• Sources for Additional Information

OVPI and Access Rate Reporting

Performance Insight is a performance management application that collects data from many 
sources, performs in-depth trend analysis, maintains performance baselines, and provides 
users with convenient, web-based reporting. Following is a partial list of product features:

• Distributed architecture

• Easy to scale (supports data collection from thousands of agents)

• CODA/OVPA agent support

• Multi-company security model

• Data warehousing

• Near Real Time reporting

• Forecasting 

• Extensive aggregation (by day, week, month; by location, by customer)

• Thresholding and alerting

• Easy identification of bottlenecks

• Easy assessment of capacity trends

• Accurate and timely documentation for management

• Integration with NNM

• Integration with OVO

The IP Access Rate Report Pack installs on OVPI. This report pack supplements the Interface 
Reporting Report Pack, and the Interface Reporting Report Pack is a prerequisite. The reports 
in IP Access Rate identify interfaces with high ratios of filtered traffic. If you know which 
interfaces have high ratios of filtered traffic, you know which service levels need to be 
modified to avoid congestion on the backbone.
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QoS and Committed Access Rate (CAR)

QoS refers to a network’s ability to provide better service to select traffic on IP-routed 
networks. QoS has the following goals:

• Dedicate bandwidth to particular traffic types

• Control jitter and latency (necessary for real-time, interactive traffic) 

• Improve loss characteristics 

Committed Access Rate, or CAR, is a feature of Cisco IOS that lets you assign a rate limit 
policy to a router interface. The policy controls how much traffic gets transmitted and how 
much traffic gets dropped. The policy functions as a uni-directional rule, or rate-limiting 
object (RLO). A byte or package that exceeds the RLO will be dropped (filtered out) at the 
interface. If the ratio of dropped traffic is high and stays high, the customer’s level of service 
may be incorrect. Each RLO specifies one of the following actions:

• Transmit the packet

• Drop the packet

• Set IP precedence bits and transmit

• Set QoS group and transmit

• Continue [evaluate the packet using the next rate policy]

• Rewrite the IP precedence bits in the packet header and continue

IP Access Rate Reports

IP Access Rate contains four reports:

Near Real Time Activity. Highlights interfaces with high filtering ratios, based on sample 
data collected over the previous six hours. Identifies switched bytes, filtered bytes, and burst 
rate. Any interface that appears in this report had to have at least some policing activity over 
the previous six hours. 

Recent Activity. Filtering activity within the most recent summarized hour for managed 
devices, split by customer. Shows switched/filtered activity per device on an hourly basis over 
the previous few days.

Historical Activity Report. A list of managed devices, split by customer, highlighting 
devices that are doing the most filtering. Ranks devices by percentage of filtered traffic. Use 
this report to find out where device utilization is above the allowed service level.

Inventory. A list of every interface in the network, with RLO configuration details. Use this 
list to examine customer configurations or to compare interfaces on different devices.

Chapter 4, Sample Reports, contains report illustration and additional descriptions.

Data Collection

IP Access Rate uses one datapipe, the Cisco IP Access Rate Datapipe to poll the CAR MIB for 
the following metrics:

• Switched bytes

• Filtered bytes

• Burst rate
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• Discards

• Errors

Adding and Modifying Properties

There is no separate property import for the reports in IP Access Rate. The property 
information that pertains to an interface, such as interface speed, customer, location, and 
device name, is inherited from two external sources: 

• The property import utility bundled with the Interface Reporting Report Pack

• Common Property Tables 

For more information about how to modify property data inherited from these two sources, 
refer to the following manuals:

• Interface Reporting Report Pack User Guide

• Common Property Tables User Guide 

Integration with NNM

If you use NNM as well as PI, you have the option of improving your ability to isolate faults 
and diagnose problems by integrating PI with NNM. To integrate PI and NNM, run the 
integration script on NNM and open the Integration Wizard on PI.

If NNM and PI are integrated, we recommend installing the optional thresholds sub-package 
that comes with IP Access Rate. Installing the optional thresholds sub-package delivers a 
customized thresholds policy to the Thresholds Module, which uses the policy to monitor the 
database for threshold conditions and respond to breaches by taking an action in accordance 
with category, severity, and destination parameters. The default response is to send a breach 
trap to NNM. The breach trap received by NNM becomes an alarm in the NNM alarm 
browser. The NNM operator can respond to the alarm by launching a Near Real Time report. 

Configuring the Thresholds Module is not necessary. You do not need to define an action or 
specify a destination for breach traps. However, you are free to modify category, severity, and 
destination parameters at any time. For details about these options, refer to the Thresholds 
Module User Guide.

Package Version History

The following table outlines recent enhancements to the IP Access Rate Report Pack.

Version Release Date Enhancements

1.0 May 2003 4 reports, no forms; Sybase support

2.0 October 2003 PI Object Manager support; thresholds sub-package

3.0 April 2004 PI 5.0 support; Oracle support

3.0 August 2004 Upgrade package (“to_3.0”)
Overview 9



Ways to Customize Reports

You can change the contents of a report by applying group filters (not related to traffic 
filtering mentioned above), by updating property information, by applying constraints, and by 
editing tables and graphs. For details about view options for tables and graphs, see Appendix 
A, Editing Tables and Graphs. 

Group Filters

If you want to share reports with your customers, you must configure PI to produce 
customer-specific reports. Here is an overview of the steps involved:

• Use Common Property Tables to import customer names and device locations

• Create a group account for all the users affiliated with each customer

• Create a group filter for each group account

For more information about group filters, refer to the PI Administration Guide. 

Applying Constraints

When you edit a parameter, you apply a constraint to the report. If you edit the Customer 
Name parameter, data for all customers except the customer you typed in the Customer Name 
field will drop from the report. If you edit the Source Location, data for all locations except the 
location you typed in the Source Location field will drop from the report.

IP Access Rate supports the following parameters: 

3.1 April 2007 new features:
• Location Independent Reporting (LIR)
• Supports Management Console > Copy Policy Manager

• Top level table of NRT reports no longer shows rate data
• SQL modified to support IR node/interface delete
new release of the datapipe:
• Cisco IPAccessRate Datapipe 3.1
new upgrade package:
• UPGRADE_IPAccessRate_Reporting_to_31

3.1 October 2007 new prerequisites:
• PI 5.3
• Common Property Tables 3.7
new release of the datapipe:
• Cisco IPAccessRate Datapipe 3.2
defect fix: 
• QXCR1000348781: IP Access Rate list not showing 

correctly

Version Release Date Enhancements
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• Customer Name

• Customer ID

• Device Name

• Interface Name

• Admin Status

• Location Name

You can apply multiple constraints at once. If you are viewing the report remotely (using the 
Web Access Server), apply a constraint by clicking the edit parameters icon at the bottom 
right-hand corner of the report. When the Edit Parameters window opens, enter the 
constraint in the field and click Submit. 

If you are using Report Viewer, select Edit > Parameter Values from the menu bar. When the 
Modify Parameter Values window opens, click the Current Value field. Type a new value and 
click OK.

Sources for Additional Information

The demo package that comes with IP Access Rate contains a sample of each report in the 
package. If you have access to the demo package and you want to know what fully-populated 
reports look like, install the demo package. Demo reports are interactive. Selection tables are 
linked to graphs and you can experiment with constraints and view options. 

For information about the latest changes to this package and any known problems, refer to:

• IP Access Rate Report Pack Release Notes

• PI Report Packs, CD-ROM Release Notes, October 2007

For details about related packages, refer to the following documents:

• IP QoS Statistics Report Pack User Guide

• Interface Reporting Report Pack User Guide

• Common Property Tables User Guide

Manuals for the core product, OVPI, and manuals for the reporting solutions and shared 
packages that run on OVPI, can be downloaded from this site:

http://ovweb.external.hp.com/lpe/doc_serv/ 

The user guides for OVPI are listed under Performance Insight. The user guides for report 
packs and datapipes are listed under Performance Insight Report Packs. Each manual indicates 
a date. If the manual is revised and reposted, the date will change. Since we post revised 
manuals on a regular basis, you should check this site for updates.
Overview 11
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2 Package Installation
This chapter covers the following topics:

• Prerequisites for Installation

• Upgrading to Version 3.1

• Installing IP Access Rate 3.1

• Accessing Deployed Reports

• Package Removal

Prerequisites for Installation

The report pack CD-ROM contains report packs, datapipes, and several shared packages. 
When you insert the CD in the drive and launch the package extraction program, the install 
script on the CD extracts every package from the CD and copies the results to the Packages 
directory on your system. After the extract finishes, the install script prompts you to launch 
PI and start Package Manager. Before using Package Manager, be familiar with the following 
guidelines. IP Access Rate has a combination of core-product requirements and package-level 
requirements. The core product requirements are as follows:

• PI 5.3

• All available Service Packs for the version of PI (5.3) you are running

You can find information about each service pack, including installation instructions, in the 
release notes for the service pack. The package-level prerequisites are as follows: 

• Common Property Tables 3.7

• Interface Reporting Report Pack 5.3

• Interface Discovery Datapipe 2.5

• Interface Reporting ifEntry Datapipe 2.5

Common Property Tables

If you are running Common Property Tables 3.6 or earlier, upgrade to the latest version by 
installing the upgrade package. Installing this upgrade package is no different from installing 
other upgrade package; however, do not install the upgrade for Common Property Tables and 
other packages at the same time. Install the upgrade package for Common Property Tables 
and only the upgrade package for Common Property Tables.
  13



Distributed Environments

If you are running IP Access Rate as a distributed system across multiple servers, the central 
server, every satellite server, and every remote poller must be running the same version of PI 
and all available service packs for the version you are running. Following is a summary of the 
install procedure for distributed environments:

• Disable trendcopy on the central server.

• Install IP Access Rate on the central server; deploy reports. 

• Install the following packages on each satellite server:

— IP Access Rate; if you want local reporting, deploy reports

— IPAccessRate_Reporting_Thresholds (optional)

— Cisco IP Access Rate Datapipe

• Re-enable trendcopy on the central server.

• When you finish installing packages, configure your central and satellite servers by 
following the steps in Chapter 3, Setting Up a Distributed System. 

Optional Thresholds Sub-Package

If PI and NNM are integrated, you have the option of launching IP Access Rate reports from 
NNM in response to alarms that show up in the NNM alarm browser. To enable this option, 
install this package:

 IPAccessRate_Reporting_Thresholds

The thresholds sub-package cannot operate without the Threshold and Event Generation 
Module, commonly known as the Thresholds Module. If you select the thresholds sub-package 
for installation, Package Manager will select and install the Thresholds Module for you.

Upgrading to Version 3.1

When you are upgrading a report pack, you first task is to delete the old datapipe. Before you 
delete the old datapipe, you may need to save configuration data related to polling policies and 
polling groups. In addition, you may need to delete any custom table views that you created 
yourself. 

Datapipes and Remote Pollers

When you uninstall an existing datapipe, the following information will be lost:

• The polling policy for a single remote poller

• Cloned polling policies for multiple remote pollers

• Customized polling groups 

You can export existing polling policy configurations and customized polling groups by using 
the collection_manager and group_manager commands.
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Exporting Polling Policy Configurations

If your environment contains polling policies for remote pollers, use the collection_manager 
command to export existing policy configurations to a file. 

UNIX: As user trendadm, run the following command: 

cd $DPIPE_HOME

./bin/collection_manager -export -file /tmp/savePollingPolicy.lst

Windows: As Administrator, launch a command window. Navigate to the OVPI install 
directory and execute the following command: 

bin\collection_manager -export -file \temp\savePollingPolicy.lst

Exporting Polling Group Configurations

If your environment contains customized polling groups, use the group_manager command to 
export groups to individual .xml files. 

UNIX: As user trendadm, execute the following command: 

cd $DPIPE_HOME

./bin/group_manager -export_all -outfile /tmp/savePollingGroups

Windows: As Administrator, launch a command window, then navigate to the OVPI install 
directory and execute the following command: 

bin\group_manager -export_all -outfile \temp\savePollingGroups

Custom Table Views

If you created custom views for data tables or property tables, the views you created may 
interfere with the report pack upgrade process. Whether or not your custom views interfere 
with the upgrade process depends on how you created them. If you created them using SQL, 
the upgrade will succeed but your views will not be available after the upgrade is complete. If 
you created them using Datapipe Manager, the upgrade is likely to fail. To prevent the 
upgrade from failing, delete your custom views before upgrading the report pack, then 
recreate them after the upgrade is complete.

Upgrading to IP Access Rate 3.1

Follow these steps to upgrade IP Access Rate:

1 Start Package Manager; delete Cisco IP Access Rate Datapipe 3.1.

2 Click Done when the removal finishes.

3 Start Package Manager; install the following package by itself, with no other packages:

UPGRADE_IPAccessRate_Reporting_to_3.1

4 Click Done when the install finishes.

5 Start Package Manage; install Cisco IP Access Rate Datapipe 3.2.

6 Click Done when the install finishes.
Package Installation 15



Installing IP Access Rate 3.1

Follow these steps to install the IP Access Rate Report Pack for the first time:

• Task 1: Stop OVPI Timer and extract packages from the report pack CD

• Task 2: If necessary, upgrade Common Property Tables

• Task 3: Install the following packages:

— IP Access Rate 3.1

— Cisco IPAccessRate Datapipe 3.2

— IPAccessRate_Reporting_Thresholds (optional)

Task 1: Stop OVPI Timer and extract packages from the report pack CD

1 Log in to the system. On UNIX systems, log in as root.

2 Stop OVPI Timer and wait for processes to terminate.

Windows: Select Control Panel > Administrative Tools > Services

UNIX: As root, do one of the following:

HP-UX: sh /sbin/init.d/ovpi_timer stop

Sun: sh /etc/init.d/ovpi_timer stop

3 Insert the report pack CD. On Windows, a Main Menu displays automatically. On UNIX, 
the CD may or may not mount automatically; if it does not mount automatically, navigate 
to the top level directory on the CD, and run the ./setup command. 

4 Type 1 in the choice field and press Enter. The install script displays a percentage complete 
bar. When the copy is complete, the install script starts Package Manager. The Package 
Manager install wizard opens.

When the copy to the Packages directory is complete, you have the option of navigating to the 
Packages directory to see the results. The Packages directory contains separate folders for the 
report pack and the datapipe. The following folders appear under IP Access Rate:

• IPAccessRate_Reporting.ap

• IPAccessRate_Reporting_Demo.ap

• IPAccessRate_Reporting_Thresholds.ap

• UPGRADE_IPAccessRate_Reporting_to_31

You can ignore the upgrade package. The following folder appears under Cisco IPAccessRate 
Datapipe:

• Cisco_IPAccessRate_Datapipe.ap

Task 2: If necessary, upgrade Common Property Tables

IP Access Rate requires Common Property Tables 3.7. If you are currently using an earlier 
release, start Package Manager and upgrade to version 3.7. When Package Manager indicates 
that the upgrade package is complete, click Done to return to the Management Console. 

If you are not running any version of Common Property Tables, skip this task and let Package 
Manager install the latest version of Common Property Tables for you, automatically.
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Task 3: Install IP Access Rate, the datapipe, and the optional thresholds package

1 Start Package Manager. The Package Manager install wizard opens.

2 Click Next. The Package Location window opens.

3 Click Install. Approve the default installation directory or use the browse feature to select 
a different directory if necessary.

4 Click Next. The Report Deployment window opens. Accept the default for Deploy Reports; 
accept the defaults for application server name and port; type your user name and 
password for the OVPI Application Server. 

5 Click Next. The Package Selection window opens.

6 Click the check box next to the following packages:

IPAccessRate_Reporting

IPAccessRate_ Reporting_Thresholds (optional)

IPAccessRate_Reporting_Demo

Cisco_IPAccessRate_Datapipe

7 Click Next. The Type Discovery window opens. Keep the default and click Next. The 
Selection Summary window opens.

8 Click Install. The Install Progress window opens. When installation finishes, an install 
complete message appears.

9 Click Done to return to the Management Console. 

10 Restart OVPI Timer.

Windows: Select Control Panel > Administrative Tools > Services

UNIX: As root, do one of the following:

HP-UX: sh /sbin/init.d/ovpi_timer start

Sun: sh /etc/init.d/ovpi_timer start

Accessing Deployed Reports

When you installed IP Access Rate, you enabled the Deploy Reports option. As a result, the 
reports in this package (as well as any forms associated with the package) were deployed to 
the OVPI Application Server. Once reports reside on the OVPI Application Server, you have 
two ways to view them:

• OVPI client applications

• Web browser

If the client applications are installed on your system, you have access to Report Viewer, 
Report Builder, and the Management Console. If the client applications are not installed on 
your system, using a web browser is the only way you can view reports.

For more information about the clients, refer to the PI Installation Guide. For details about 
the Management Console, including how to use the Object/Property Management view to 
launch reports specific to a selected object, refer to the PI Administration Guide.
Package Installation 17



Package Removal 

Follow these steps to uninstall IP Access Rate and the Cisco IP Access Rate Datapipe:

1 Log in to the system. On UNIX systems, log in as root.

2 Stop OVPI Timer and wait for processes to terminate.

Windows: Select Control Panel > Administrative Tools > Services

UNIX: As root, do one of the following:

HP-UX: sh /sbin/init.d/ovpi_timer stop

Sun: sh /etc/init.d/ovpi_timer stop

3 Start Package Manager. The Package Manager window opens.

4 Click Next. The Package Location window opens.

5 Click Uninstall. Keep the defaults.

6 Click Next. The Package Selection window opens.

7 Click the check box next to the following packages:

IPAccessRate_Reporting

IPAccessRate_ Reporting_Thresholds (if installed) 

IPAccessRate_Reporting_Demo (if installed)

Cisco_IPAccessRate_Datapipe

8 Click Next. The Selection Summary window opens.

9 Click Uninstall. The Progress window opens. When the removal finishes, a removal 
complete message appears. 

10 Click Done to return to the Management Console.

11 Restart OVPI Timer.

Windows: Select Control Panel > Administrative Tools > Services

UNIX: As root, do one of the following:

HP-UX: sh /sbin/init.d/ovpi_timer start

Sun: sh /etc/init.d/ovpi_timer start
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3 Setting Up a Distributed System
These are the steps to follow when setting up a distributed system:

• Decide whether or not you want local reporting

• Install the right set of packages on each server (a central server that is not polling will not 
need datapipes; the satellite servers will need datapipes)

• Verify that the system clocks in your environment are synchronized

• Register your satellite servers

• If you are not copying rate data to the central server, enable LIR on the central server

• If you enable LIR, add LIR mapping with the time type set to rate

• Verify that you have all the copy policies you need

• Configure the central server (manual edits to trendtimer.sched and .pro files)

• Configure each satellite server (manual edits to trendtimer.sched and .pro files)

If you want to set up a distributed system, you can implement local reporting or you can 
implement centralized reporting. If you want local reporting, you need to deploy reports when 
you install the report pack on each satellite server, and you need to allow summarizations to 
run on each satellite server. If you do not want local reporting, then you do not need to deploy 
reports when you install a report pack on a satellite server and you can disable the scripts 
that run summarizations on each satellite server.

Before Location Independent Reporting (LIR) was available, our recommendation to anyone 
setting up a distributed system was to deploy reports on satellite servers, keep rate data on 
satellite servers, copy hourly data to the central server, and disable summarizations above the 
hourly level on satellite servers. The advantage to this approach was that it kept a large 
volume of rate data off the network and it decreased the processing load on the central server. 
The disadvantage is that the central server could not display a Near Real Time (NRT) report. 
The only NRT report was a local NRT report, on a satellite server. LIR overcomes this 
disadvantage. If you enable LIR, you can open an NRT report on the central server and 
drill-down on table selections. The selections you make cause the central server to query a 
satellite server for locally aggregated data. Of course, if you would rather copy rate data to the 
central server, you can. If you do that, then enabling LIR is not necessary.

Configuring the Central Server

To configure the central server, perform the following tasks:

• Task 1: Register the satellite server by setting the database role

• Task 2: If you are not copying rate data from satellites to the central server, enable LIR

• Task 3: If you enable LIR, add LIR mappings
  19



• Task 4: Verify the automatically generated copy policies

• Task 5: Modify the IPAR_Hourly_Process.pro file

Task 1: Register the satellite server by setting the database role

1 Start the Management Console (log on with Administrator privileges).

2 Click the Systems icon in the navigation pane.

3 Navigate to the OVPI Databases folder and select the database system.

4 Click Database Properties.

5 From the Database Role list, select the Satellite Server role.

6 Enter any information necessary to configure the Satellite Server role.

Task 2: Enable LIR

1 Start the Management Console (log on with Administrator privileges).

2 Click the Systems icon in the navigation pane.

3 Navigate to the OVPI Databases folder and select the central server.

4 Click LIR Configuration.

5 Select the LIR enabled check box.

Task 3: Add LIR mappings

1 Start the Management Console (log on with Administrator privileges).

2 Click the Systems icon in the navigation pane.

3 Navigate to the OVPI Databases folder and select the central server.

4 Click LIR Configuration.

5 Click Add Mapping.

6 From the Select Satellite Server list, select a satellite server to which to add a mapping.

7 Select the Category data table option.

8 Select IP Access Rate from the drop down list.

9 Select the rate data type.

10 Click Add to List.

11 If you want to add additional LIR mappings, click Add to list and repeat step 6 through 
step 10.

12 Click OK.

13 Click Apply.

A copy policy is automatically generated for the hourly data and for each LIR mapping that 
you add. The data type selected when adding an LIR mapping (in step 9 above) determines 
the type of data copied that is defined in the generated copy policy (the type of data copied 
that is defined in the generated copy policy is for one greater than the data type selected in 
the LIR mapping). For example, if you select an hourly data type, a daily data copy policy is 
generated.

To add a new database reference, you can use the Add Database Reference Wizard in the 
System and Network Administration application.
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Task 4: Verify the automatically generated copy policies

Verify that a copy policy has been generated for the SHIPARData table and that the copy type 
is set correctly (to Property and Data):

1 Start the Management Console (log on with Administrator privileges).

2 Click the Copy Policy icon in the navigation pane to start the Copy Policy Manager.

3 Find the SHIPARData table and verify the copy type is set to Property and Data.

If a copy policy has not been generated for a table, do the following:

1 Click the New Copy Policy icon or select File > New Copy Policy from the Copy Policy 
Manager. The Copy Policy Wizard displays.

2 Click Next. The Satellite Server and Copy Policy Selection Page displays.

3 Select a satellite server from the pull down list. This is the satellite server from which 
data is copied to the central server.

4 Select Single Table and select SHIPARData from the pull down list.

5 Click Next. The Copy Type Selection Page displays.

6 Select Property and Data.

7 Click Next. The Summary page displays.

8 Verify the information in the summary window. If the information is not correct, you can 
modify it by clicking Back.

9 Click Finish.

If the copy type is not set to Property and Data, do the following:

1 Double-click the copy policy.

2 Select the Property and Data copy type.

3 Click OK.

Task 5: Modify the IPAR_Hourly_Process.pro file

The IPAR_Hourly_Process.pro file is found in the {DPIPE_HOME}/scripts/ directory 
where {DPIPE_HOME} is the directory in which OVPI is installed.

Make the following change to this file:

• Find and comment out the following line:

{DPIPE_HOME}/bin/trend_sum -t RIPARData -e SSHIPARData -f  
{DPIPE_HOME}/scripts/SHIPARData_Keyid.sum

Configuring a Satellite Server

Follow these steps to configure each satellite server.

1 Modify the {DPIPE_HOME}/lib/trendtimer.sched file (where {DPIPE_HOME} is the 
directory in which OVPI is installed).

Make the following changes:

• Find and comment out the following line (only if the central server is not a polling 
server):
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24:00+3:00 - - {DPIPE_HOME}/bin/trend_proc -f  
{DPIPE_HOME}/scripts/IPAR_DMF_Process.pro

• Find and change the following line (modify the daily processing time):

1:00+30 - - {DPIPE_HOME}/bin/trend_proc -f  
{DPIPE_HOME}/scripts/IPAR_Hourly_Process.pro

to

1:00+15 - - {DPIPE_HOME}/bin/trend_proc -f  
{DPIPE_HOME}/scripts/IPAR_Hourly_Process.pro

2 Modify the IPAR_Hourly_Process.pro file.

The IPAR_Hourly_Process.pro file is found in the {DPIPE_HOME}/scripts/ 
directory where {DPIPE_HOME} is the directory in which OVPI is installed.

Make the following changes:

• Find and comment out the following lines:

{DPIPE_HOME}/bin/trend_sum -t SHVIPARData -e SHIPARInterfaceData -f  
{DPIPE_HOME}/scripts/SHIPARInterfaceData_Interface.sum

{DPIPE_HOME}/bin/trend_sum -t SHIPARInterfaceData -e SHIPARDeviceData 
-f {DPIPE_HOME}/scripts/SHIPARDeviceData_Cust_Device.sum

{DPIPE_HOME}/bin/trend_sum -t SHIPARInterfaceData -e SHIPARDeviceData 
-f {DPIPE_HOME}/scripts/SHIPARDeviceData_Cust.sum

{DPIPE_HOME}/bin/trend_sum -t SHIPARInterfaceData -e SHIPARDeviceData 
-f {DPIPE_HOME}/scripts/SHIPARDeviceData_All.sum

{DPIPE_HOME}/bin/trend_sum -t SHIPARInterfaceData -e SHIPARDeviceData 
-f {DPIPE_HOME}/scripts/SHIPARDeviceData_Device.sum

• Find and uncomment the following lines:

begin:IPAR_2 wait

end:IPAR_2

3 Configure polling policies for the Cisco IPAccessRate Datapipe. Make sure that each 
interface is polled by one satellite server only.

System Clocks

Make sure that the system clock on each satellite server is synchronized with the system clock 
on the central server.
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4 Sample Reports
Near Real Time Interface Activity

This report highlights RLO interfaces with a high proportion of filtered traffic. The entries in 
the selection table sort according to the filtered/switched ratio, highest to lowest. If you see an 
interface with a high proportion of filtered traffic, you can inspect the rate limiting rules that 
apply to the interface. 

The graphs provide details for the ratio of filtered traffic to all traffic (in bytes), the ratio of 
filtered traffic to switched traffic, and the current burst traffic rate. The graphs show data 
collected over the previous six hours, for switched traffic, filtered traffic, and burst rate. The 
graph at the bottom shows utilization, errors, and discards over the previous six hours.

Recent IP Access Rate Activity 

The design of this report is unusual compared to most OVPI reports. If you select a customer 
from the pick-list, the table to the right populates with a list of devices operated by that 
customer that have seen rate-limited interfaces with activity during the previous hour. The 
list of devices also indicates the amount of traffic filtered, the amount switched, and the ratio 
of filtered to switched traffic expressed as a percentage. Once you select a device from the list 
of devices, the three tables below update simultaneously, showing:

• Provisioning information at the device level

• The rate-limited interfaces on the selected device

• The RLOs configured for each interface

The graph at the bottom of the report compares the volume of conform traffic to the volume of 
exceed traffic from multiple perspectives—the device, the interface, and the RLO.

Historical IP Access Rate Activity

This report looks at yesterday’s filtering activity and sorts devices by filtering from highest to 
lowest. The list of devices indicates totals for switched packages, filtered packets, switched 
bytes, and filtered bytes. Drill down on a selected device to display a list of rate limited 
interfaces. 

Use this report to determine which devices are exceeding rate limits and which customers 
may be transmitting more data than their service level can accommodate. Use the hourly 
chart at the bottom of the report to find out exactly when filtering took place. Compare the 
hourly chart to the daily and monthly charts to find out whether yesterday’s filtering activity 
is consistent with a longer-term trend, or an isolated incident.
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Inventory Report

This report provides a list of all the interfaces in the network and the rate limit objects 
configured for each interface. Use this report to examine customer configurations or to 
compare individual interfaces on different devices. The details about interfaces and rate limit 
objects are updated after every poll cycle. The list of customers is refreshed every evening.

Selecting a customer from the pick-list displays a list of the interfaces belonging to that 
customer that are configured with rate-limit objects. Select an interface from this list to 
display values for:

• Direction

• Rate index

• Conformance action

• Exceed action

• Limit

• Extended limit

• Access list number
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A Editing Tables and Graphs
Any table or graph can be viewed in several ways. While the default view is usually adequate, 
you can easily change to a different view. If you are using Report Viewer, right-click the object 
to display a list of view options. If you are using the Web Access Server, follow these steps to 
change the default view of a table or graph:

1 Click Preferences on the links bar.

2 Expand Reports in the navigation frame.

3 Click Viewing.

4 Select the Allow element editing box.

5 Click Apply.

6 Click  (the Edit icon) next to the table or graph. 

View Options for Tables

Right-clicking a table, or selecting the Edit Table icon if you are using the Web Access Server, 
opens a list of table view options.

Select Set Time Period to alter the relative time period (relative to now) or set an absolute time 
period. The Set Time Period window opens.

You may shorten the period of time covered by the table from, for example, 42 days to 30 days 
or to 7 days. If you are interested in a specific period of time that starts in the past and stops 
before yesterday, click Use Absolute Time and select a Start Time and an End Time.

Select Change Constraint Values to loosen or tighten a constraint, thereby raising or lowering 
the number of elements that conform to the constraint. The Change Constraint Values 
window opens. To loosen a constraint, set the value lower; to tighten a constraint, set the 
value higher.
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The Select Nodes/Interfaces allows you to change the scope of the table by limiting the table to 
specific nodes, specific interfaces, or a specific group of nodes or interfaces. The Select Node 
Selection Type window opens.
Change Max Rows increases or decreases the number of rows in a table. The default is 50. If 
you expand the default, the table may take more time to open. If you are trending a large 
network, using the default ensures that the table opens as quickly as possible. 
View in new Frame opens the table in a Table Viewer window, shown below. If necessary, make 
the data in the table more legible by resizing the window. 

View Options for Graphs

Right-clicking a graph, or clicking the Edit Graph icon if you are using the Web Access Server, 
opens the following list of view options. 
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The following table provides details about each option.

Style Options

Select Style to display a list of seven view options for graphs.

Option Function

Set Time Period Same as the table option shown above.

Change Constraint Values Same as the table option shown above.

Select Nodes/Interfaces Same as the table option shown above.

Displayed Data For every point on a graph, display data in a 
spreadsheet.

Grid Add these to the graph:
X axis grid lines
Y axis grid lines
X and Y axis grid lines

Legend Delete or reposition the legend. 

Style See the illustrations below.

Change Max Rows... Same as the table option shown above.

Display Data Table See below.

Export Element as CSV... Same as the table option shown above.

View in New Frame Opens graph in a Graph Viewer window.

Print Graph Same as the table option shown above.
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Style > Area

The plot or bar chart changes to an area graph. While relative values and total values are 
easy to view in this format, absolute values for smaller data types may be hard to see. Click 
anywhere within a band of color to display the exact value for that location 

To shorten the time span of a graph, press SHIFT+ALT and use the left mouse button to 
highlight the time span you want to focus on. Release the mouse button to display the selected 
time span.

Style > Stacking Area

The area or plot graph changes to a stacking area graph. This view is suitable for displaying a 
small number of variables.
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Style > Bar

The graph changes to a bar chart. This view is suitable for displaying relatively equal values 
for a small number of variables. There are three variables in the graph below.

Style > Stacking Bar

The plot or area graph changes to a stacking bar chart. If you increase the width of the frame, 
the time scale becomes hourly. If you increase the height of the frame, the call volume shows 
in units of ten.
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Style > Plot

Bands of color in an area graph change to lines. If you adjust the frame width, you can make 
the data points align with hour; if you adjust the frame height, you can turn call volume into 
whole numbers.

Style > Pie

An area graph becomes a pie chart. Bands in an area graph convert to slices of a pie and the 
pie constitutes a 24-hour period. This view is helpful when a small number of data values are 
represented and you are looking at data for one day.

If you are looking at data for more than one day, you will see one pie graph for each day. 
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Display Data Table

This option changes a graph into a spreadsheet. 

View in New Frame

The graph opens in a Graph Viewer window. Improve legibility by resizing the window. 
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Glossary
accldx

Access List Number. The index to the access list if Rate Limit Type is either quickAcc or standardAcc. 

conform act

Conform Action. The action taken for those packets that conformed with the rate limit. 

exceed act 

Exceed Action. The action taken for those packets that exceeded the rate limit. 

ext limit

Extended limit. The excess burst size in bytes. The amount of traffic, in bytes, in excess of the burst limit 
that may be permitted by the rate limit rule. 

filtered 

A byte or packet that exceeded the rate limit and was dropped at the interface. 

filtered/switched ratio

A low ratio indicates that few packets are being dropped, a high ratio indicates that many packets are being 
dropped. The end user wants to keep the ratio low. The service provider wants to prevent congestion on the 
backbone to a minimum. A high ratio could indicate that a customer needs a different service level.

limit

Traffic above the CIR that is instantly permitted by the rate limit rule. Synonymous with normal burst size 
measured in bytes.

Near Real Time (NRT)

A report containing a rolling average for performance over the last six hours. The most recent data in this 
report was collected by the most recent poll, which probably took place within the last 15 minutes.

rate data

This is an OVPI term. Rate data is data as it was collected; the actual samples, without summarizing the data 
by hour. Rate data appears in Near Real Time reports. 

rate index 

An arbitrary index for rate limit objects. It will increase as the list is traversed, but may skip. 

rate

Transmission rate or sustained rate permitted by the rate limit rule.
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rate limit object

A rule or regulator applied to traffic at the interface level, moving in a given direction. Rate limiters are 
defined by a series of settings and actions. Typically, lower priority traffic will pass by multiple limiters, 
while higher priority traffic will be subject to one limiter only. 

switched

A byte or packet that was transmitted normally and was not dropped. 
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